This is an optional page.
Nova Southeastern University
Graduate School of Humanities and Social Sciences

This dissertation was submitted by _________________ under the direction of the chair of the dissertation committee listed below. It was submitted to the Graduate School of Humanities and Social Sciences and approved in partial fulfillment for the degree of Doctor of Philosophy in Conflict Analysis and Resolution at Nova Southeastern University.

Approved:

____________________    _____________________
Date of Defense     Committee Chair Name.
Chair

____________________
Committee Member Name.

____________________
Committee Member Name.

____________________    _____________________
Date of Final Approval    Committee Chair Name
Chair
Dedication

This is an optional page for a dedication. If you include a dedication, use regular paragraph spacing as shown here (not centered, italicized, or otherwise formatted). If you do not wish to include this page, delete the heading, the body text, and the page break below the end of the text.
Acknowledgments

This is an optional page for acknowledgments. It is a nice place to thank the faculty, family members, and friends who have helped you reach this point in your academic career.

No page number appears on any of the pages up to this point. If you do not wish to include this page, delete the heading and the body text; if a blank page remains, delete the page break above but leave the section break that you see below this text.
Table of Contents

List of Tables ........................................................................................................................................... ii

List of Figures ........................................................................................................................................... iii

Abstract....................................................................................................................................................... iv

Chapter 1: Introduction to the Study (Level 0 Heading) ........................................................................... 1

  Background.............................................................................................................................................. Error! Bookmark not defined.

    APA Level 2 Heading............................................................................................................................... 1

Chapter 2: Literature Review ....................................................................................................................... 3

  First Heading.......................................................................................................................................... 3

Chapter 3: Research Method ....................................................................................................................... 4

  First Heading.......................................................................................................................................... 4

Chapter 4: Results ...................................................................................................................................... 5

  First Heading.......................................................................................................................................... 5

Chapter 5: Discussion, Conclusions, and Recommendations .................................................................... 7

  First Heading.......................................................................................................................................... 7

References.................................................................................................................................................... 8

Appendix A: Title of Appendix ................................................................................................................... 9

Curriculum Vitae ....................................................................................................................................... Error! Bookmark not defined.

Use this table of contents (TOC) as an example of what one looks like. When it comes time for creating your own TOC, RIGHT CLICK anywhere in the Table of Contents, select UPDATE FIELD, then select UPDATE ENTIRE TABLE or UPDATE PAGE NUMBERS ONLY, and click OK.

The table of contents will be generated using the style tags from the template; you will also be able to automatically update the TOC, both added headings and page numbers.
List of Tables

Table 1. A Sample Table Showing Correct Formatting ..................................................... 5

When you update the list of tables, the table number and title will come in without a period between them; you will need to manually add that period after all table numbers, as shown for Table 1. In addition, the title will retain the italics from the narrative when the List of Tables is updated. Once your list is finalized, select the entire list and change it all plain type.
List of Figures

Figure 1. Figure caption goes here.....................................................................................xx

The List of Figures is not set up to automatically update. If you have figures in your document, type them in manually here, following the example above.

Alternately, follow these instructions, which will allow automatic updating of the List of Figures:

1. Use the cursor to highlight the figure number and caption where they appear in the narrative chapters. (Figure 1. Figure caption.)
2. Press Shift + Alt + the letter o). In the Mark Table of Contents Entry that comes up, you will see the figure information that you highlighted in the Entry box. Put A in the Table Identifier box. Put 1 in the Level box. Do not close the Mark Table of Contents Entry box. Work can be done while it is open.
3. Continue to follow this protocol for all figures. You will see parenthetical entry field coding beside each figure caption when you have the formatting showing.
4. Close Mark Table of Contents Entry box.
5. Place your cursor on the List of Figures page in the TOC.
6. Open the References tab.
7. Left click Insert Tables of Figures.
8. In the Table of Figures box that comes up, put a check in the “Show page numbers” and “Right align page numbers boxes.” Remove the check from the hyperlink box. Put dot leaders in the Tab leader box. Under General, format is “from template.” Caption label is “Figure.” Put a check in the “Include label and number” box.
9. Go to Options. Remove check from “style” box. Put a check in the “Table entry fields” box. Put A in the Table identifier box. Click OK. Click OK again on initial Table of Figures box.
10. The figures will appear on the List of Figures page. You may have to reformat the spacing and font. If the captions themselves change in the narrative, this whole process must be repeated. If only the page numbers change, do this:
   a. Left click to place the cursor anywhere on the figures mentioned on the List of Figures page.
   b. Right click “Update field.”
   c. Place bullet in circle for option to update page numbers only.
   d. Left click OK.
   e. The page numbers will update automatically.
Abstract

Insert abstract here; it should be no more than one page. Abstract text must be double-spaced with no paragraph breaks. Describe the overall research problem being addressed in the first couple of sentences and indicate why it is important (e.g., who would care if the problem is solved). You can include a general introduction of the issue in the first sentence, but you need to move to a clear statement of the research problem being addressed. Identify the purpose and theoretical foundations, if appropriate, summarize the key research question(s), and briefly describe the overall research design, methods and data analytic procedures. Identify the key results, one or two conclusions, and recommendations that capture the heart of the research. Conclude with a statement on the implications for positive social change. Here are some form and style tips: (a) limit the abstract to one typed page; (b) maintain the scholarly language used throughout the dissertation; (c) keep the abstract concise, accurate, and readable; (d) use correct English; (e) ensure each sentence adds value to the reader’s understanding of the research; and (f) use the full name of any acronym and include the acronym in parentheses. Do not include references or citations in the abstract. Per APA style, unless at the start of a sentence, use numerals in the abstract, not written out numbers.
Chapter 1: Introduction to the Study (Level 0 Heading)

Opening paragraph starts here

**Level 1 Heading**

Place your text here.

**APA Level 2 Heading**

Place your text here; when placing your cursor on this text, you will see in the style menu that this paragraph is tagged “Body Text.” That means it will automatically appear double-spaced with the first line indented, per SHSS style. The sixth edition of the APA manual advises two character spaces between sentences. Either one or two spaces; either is acceptable, just be consistent. The text in this template has one character space between sentences.

You can find the style menu in Word 2007 by clicking on the Home tab on the standard toolbar; Styles is one of the choices you will see. Click on the arrow icon on the right side of the Styles bar, and the drop-down menu of styles will appear. In Word 2003, look in the upper left corner of your screen, on the formatting toolbar, for the drop-down style menu.

To apply this template’s formatting to the text of your paper, simply highlight the paragraph(s) or heading you want to format, and choose the appropriate tag from the style menu. The list of style tags includes all levels of headings, block quotes, table and figure captions, references, and body text.

**APA level 3 heading.** Text begins here.
APA level 4 heading. Text begins here. The following is an example of a block quote:

This is an example of a block quote. Now is the time to do the work that needs to be done. This is an example of a block quote. Now is the time to do the work that needs to be done. This is an example of a block quote. Now is the time to do the work that needs to be done. This is an example of a block quote. Now is the time to do the work that needs to be done. (Author, date, p. #)

If you make a mistake and something changes that you did not want to change, in Word 2007, either type Ctrl (Control key) z or, on the Quick Access toolbar, next to Save, click on the arrow icon for Undo. In Word 2003, go to Edit, Undo Typing.

As you continue to develop your proposal and dissertation in this template, use the instructions in Comments 9 to 12 to add new headings and new text.
Chapter 2: Literature Review

First Heading

Insert the text of your literature review here. Report the literature in past tense, as in Jones (2003) argued, not Jones (2003) argues. Refer to the rubric for guidance on the content of sections in this chapter.

Here are some additional tips for presenting data in vertical list form.

1. In the body of your paper, use this format when presenting information as a vertical list.

2. When the order of the items in the list is important, use a numbered list. Use a bulleted vertical list when you do not need to indicate a certain order or chronology.

- This is an example of a bulleted list.

- It follows the same format as for a numbered list, with the bullet point indented the same as a paragraph indent.
Chapter 3: Research Method

First Heading

Discuss your research method here. Refer to the rubric for guidance on the content of sections in this chapter.
Chapter 4: Results

First Heading

Present your results here. Refer to the rubric for guidance on the content of sections in this chapter.

This is an example of a table in APA style (see Table 1).

Table 1

*A Sample Table Showing Correct Formatting*

<table>
<thead>
<tr>
<th></th>
<th>Column A</th>
<th>Column B</th>
<th>Column C</th>
<th>Column D</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Row 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This is an example of a figure labeled per APA style. Note that the label is placed under the figure itself. As with tables, refer to the figure by number in the narrative text preceding the placement of the figure (see Figure 1).

[place figure here]

Figure 1. This is a sample of a figure caption.

Follow these instructions to allow figure number and caption to update in the List of Figures.

1. Use the cursor to highlight the figure number and caption. (Figure 1. Text.)
2. Press Shift + Alt + the letter o). In the Mark Table of Contents Entry that comes up, you will see the figure information that you highlighted in the Entry box. Put A in the Table Identifier box. Put 1 in the Level box. Do not close the Mark Table of Contents Entry box. Work can be done while it is open.
3. Continue to follow this protocol for all figures. You will see parenthetical entry field coding beside each figure caption.
4. Close Mark Table of Contents Entry box.
5. Place your cursor on the List of Figures page in the TOC.
6. Open the References tab.
7. Left click Insert Tables of Figures.
8. In the Table of Figures box that comes up, put a check in the “Show page numbers” and “Right align page numbers boxes.” Remove the check from the hyperlink box. Put dot leaders in the Tab leader box. Under General, format is “from template.” Caption label is “Figure.” Put a check in the “Include label and number” box.
9. Go to Options. Remove check from “style” box. Put a check in the “Table entry fields” box. Put A in the Table identifier box. Click OK. Click OK again on initial Table of Figures box.
10. The figures will appear on the List of Tables page. You may have to reformat the spacing and font. If the captions themselves change, this whole process must be repeated. If only the page numbers change, do this:
   a. Left click to place the cursor anywhere on the figures mentioned on the List of Figures page.
   b. Right click “Update field.”
   c. Place bullet in circle for option to update page numbers only.
   d. Left click OK.
   e. The page numbers will update automatically.
Chapter 5: Discussion, Conclusions, and Recommendations

First Heading

Insert summary, conclusions, and recommendations here. Refer to the rubric for guidance on the content of sections in this chapter.
References

Insert References here. Examples of some common types of references follow; see APA 6.22 and Chapter 7 for more details.

These sample entries are tagged with the “APA Reference” style tag, which means the line spacing and hanging indent are automatic. Apply the “APA Reference” style tag to your entries.

Pay special attention to italics, capitalization, and punctuation. The style tag does not govern those aspects of the entry.

*Periodical (journal)*


*Online periodical (journal)*


*Nonperiodical (book)*


*Chapter in a book*


Appendix A: Title of Appendix

Insert appendix here. Appendices are ordered with letters rather than numbers.

The appendices must adhere to the same margin specifications as the body of the dissertation. Photocopied or previously printed material may have to be shifted on the page or reduced in size to fit within the area bounded by the margins.

If the only thing in an appendix is a table, the table title serves as the title of the appendix; no label is needed for the table itself. If you have text in addition to a table or tables in an appendix, label the table with the letter of the appendix (e.g., Table A1, Table A2, Table B1, and so on). These tables would be listed in the List of Tables at the end of the Table of Contents.

If you include in an appendix any prepublished materials that are not in the public domain, you must also include permission to do so.

One optional appendix is a brief bio or CV.

Congratulations! This is the end of your dissertation! Be sure to delete this text!